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Overview 

Product Name 
Falcon K2 LiDAR 

Manufacturer 
SEYOND 

Legal Information 
This manual and the information contained herein are the exclusive property of Seyond Inc. and are protected by 
applicable copyright laws. The contents of this manual are subject to change without prior notice. 

Seyond has made every effort to ensure the accuracy and completeness of this document. However, should you find 
any errors or omissions, please contact Seyond Inc. We will update and correct the information as necessary in a 
timely manner. 

Manual Overview 
This manual provides detailed instructions for the Falcon K2 LiDAR (hereinafter referred to as “Falcon K2” or “the 
LiDAR”) regarding its installation, operation, maintenance, and troubleshooting. The contents are organized 
according to the various stages of the sensor’s lifecycle, including installation, configuration, and maintenance 
procedures. 

This manual is intended for use by development personnel (such as R&D engineers), installation technicians, 
electrical specialists, safety engineers, and maintenance personnel. 

Original Document 
This document is an original publication of Seyond. 

Manual Description 
This document covers general usage instructions and common troubleshooting measures. However, it may not 
address all possible issues that could arise during product use. If you encounter any problems not described in this 
manual, please contact Seyond for technical support.  

This manual will be updated as product technology evolves. For the latest version of the user manual, please consult 
the relevant personnel at Seyond Inc.. 

Contact Phone: (650)963-9573 
Email:     info@seyond.com 

Important Notes 
This user manual covers the Falcon K2 LiDAR introduction, installation, handling/transport, operation, maintenance, 
troubleshooting, end-of-life disposal, and related software instructions.  

As this product is a laser device (1550 nm), please read this manual carefully before use and observe all precautions 
to avoid hazards. During operation, strictly follow the procedures described in this manual. 
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Safety Instruction 
Before using this product, please read this manual carefully and strictly follow all operating guidelines. To reduce 
the risk of electric shock or laser exposure, and to avoid voiding the warranty, do not disassemble or modify the 
LiDAR.  

This product contains no user-serviceable parts. For maintenance or repair, please contact Seyond staff. 

 

 
Use of controls, adjustments, or performance of procedures other than 
those specified for this product may result in hazardous radiation leakage. 

 

 
� Class 1 Laser Product. 
� Failure to use, control, adjust or operate LiDAR as specified herein may 
result in serious radiation hazards. 
� The product incorporates a Class 4 fiber laser system which, by itself, 
may be hazardous. This device incorporates a protective housing and a 
scan failure safeguard in the machine design such that there is no 
exposure or human access to laser radiation generated by the fiber laser 
during operation or maintenance. 
� UNDER NO CIRCUMSTANCE shall attempts be made to operate the laser 
with protective housing removed or the scan failure safeguards 
overridden. 
□ When the laser is powered up, service procedures are only intended to 
be operated by Seyond service personnel or persons trained and certified 
by Seyond. 

 

 
This product complies with the following standards: 
•  IEC 60825-1:2007 
•  IEC 60825-1:2014 

Maintenance and Care 

This product is made of metal and plastic and contains sensitive electronic components inside. To ensure product 

reliability and user safety, please observe the following precautions: 

• Do not drop, burn, puncture, strike, or crush the product. 

• If the product has been dropped or subjected to impact, stop using it immediately and contact Seyond 
technical support for assistance. 

• If you suspect that the product is damaged in any way, discontinue use immediately to prevent injury or 
further damage. 
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• Do not touch the LiDAR optical window with your hands, as this may degrade performance.  

• If the optical window becomes contaminated, clean it according to the instructions in the Cleaning section 
of this manual. 

• Do not attempt to disassemble or service the product yourself. Unauthorized disassembly may cause 

damage, compromise waterproofing, or result in personal injury. 

Electrical Safety 
• Always use the original power cables and adapters provided by Seyond to supply power to the product. 

• Using damaged cables or adapters, especially in humid environments, may cause fire, electric shock, 

personal injury, product damage, or property loss. 

Heat dissipation 
• Prolonged contact with hot surfaces may cause discomfort or injury. 

• To prevent heat buildup, ensure adequate ventilation around the device. 

• The device surface may become warm during extended operation; allow it to cool down for several minutes 
after power-off before touching. 

Operating environment 
• Do not expose the product to excessive vibration or mechanical shock. For detailed performance 

specifications, please contact Seyond technical support for assistance.  

• Although the product is designed to meet Class 1 eye-safety standards, users should avoid direct visual 
exposure to the laser during operation to ensure maximum personal safety. Do not view the emitted laser 
through magnifying or optical instruments (such as microscopes or magnifiers). 

• Do not observe the emitted laser through other electronic or optical devices, such as camera, cell phones. 

• Do not operate or expose the product in explosive atmospheres, such as areas containing high 
concentrations of flammable chemicals or vapors 

• Do not expose the product to environments with high concentrations of industrial chemicals, including 
volatile liquefied gases (such as helium), as this may damage or degrade the product’s performance. 

Radio frequency interference 
Before operating the product, please carefully read the certification and safety information. While the product has 
been designed, tested, and manufactured in compliance with applicable radio-frequency (RF) emission standards, 
radiation emitted from the device may, in some cases, cause interference with other nearby electronic equipment. 

Medical Equipment Interference 
This product contains components and radio devices that emit electromagnetic fields, which may interfere with 
medical equipment such as cochlear implants, pacemakers, or defibrillators. Consult your physician and the 
manufacturer of your medical device for specific information regarding safe operating distances between your 
device and this product.  
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If you suspect that this product is interfering with your medical equipment, stop using it immediately and contact 
your medical professional for guidance. 
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1 Product Description 

1.1 Product introduction 

Product Introduction 
Falcon K2 LiDAR (hereinafter referred to as "Falcon K2" or " LiDAR") is an industry-leading ultra-long-range 
automotive-grade LiDAR developed by Seyond. It can achieve a maximum detection range of up to 500 meters, with 
a standard detection distance of 250 meters at 10% reflectivity.. Falcon featuring a region of interest (ROI) function 
which allows user to flexible adjust the area of interest to generate and change the high-density point clouds with 
a specific region.  This enables precise object tracking and robust perception performance, effectively meet the 
safety and reliability requirements of L2+ ADAS applications. 

Product Features 
• 500 meters Ultra-long detection range with image-grade ultra-high resolution. 
• ROI focusing with flexible, adjustable field of view. 
• 1550 nm laser wavelength ensures enhanced eye safety. 
• Automotive-grade reliability designed for mass production and long-term stability. 

1.2 Product operating principles 
 The Falcon K2 LiDAR measures distance based on the Time of Flight (TOF) principle. This method calculates the 
distance by measuring the time it takes for a laser pulse to travel to a target object and back to the receiver. 

1. The laser emitter transmits an ultra-short laser pulse. 
2. The emitted pulse hits an object and is scattered and reflected. 
3. The receiver detects the returned laser signal. 
4.  By measuring the round-trip flight time of the laser pulse in air, the system accurately computes the 

distance to the target. 
The measured distance is expressed as: 

𝑑 =
𝑐𝑡
2  

d:distance        c:speed	of	light   			  t:flight	time	of	the	laser	beam 
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Table 1  Nameplate Explanation 

Serial Number Name Serial Number Name 

1 Product Model 2 PN Code 

3 Production Date 4 CE Logo 

5 Company Logo   

1.4 LiDAR coordinate system 
The Falcon K2 is a hybrid solid-state LiDAR with a laser wavelength of 1550nm. The three-dimensional coordinate 
system is defined as follows: 

• x is perpendicular to the ground, pointing upwards. 
• y is parallel to the ground, pointing to the right. 
• z is parallel to the ground, pointing forward. 
• The coordinate origin is the calibration reference point of the LiDAR. 

 

1.5 Scanning pattern 
The Falcon K2 LiDAR adopts a two-dimensional scanning architecture. 
The Field of View (FOV) defines the total scanning area of the LiDAR. 
 • Horizontal FOV: 120° with an angular resolution of 0.2° 
 • Vertical FOV: 25° with an angular resolution of 0.24° 

Within the FOV, the Region of Interest (ROI) represents a high-density scanning area that can be dynamically 
adjusted. 
 • Horizontal ROI: 120° with an angular resolution of 0.1° 
 • Vertical ROI: 9.6°, with a resolution of 0.15° (lower 4.8°) and 0.1° (upper 4.8°) 

The ROI region can be dynamically adjusted in real time within the full FOV by sending control commands from the 
host computer to the LiDAR, as described in Appendix H. 
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1.6 Product Technical Specifications 
Table 2  Specification Table 

OPTICAL PERFORMANCE 
Range (Maximum) 500 m 
Range (Minimum) 1.5 m 
Detection Range (10% Lambertian 
reflectivity @ 10 Hz) 

250 m@100 klx sunlight, POD>90% 

Detection Range Accuracy ± 2 cm  
Note:  
Accuracy is calculated based on the discrepancy between the average of 50 
measurements on static target at a specific distance and the true distance 

Detection Range Precision * Up to 2 cm (1 standard deviation) 
Detection Range Resolution 0.5 cm 
Vertical Scanning Lines * 1500 lines/sec 
FOV in non-ROI (H×V) 120°×25° 
FOV in ROI (H×V) 120°×9.6° 
Angular Resolution in sparse (H×V)* 0.2°×0.24° 
Angular Resolution in ROI (H×V)* 0.1°×0.15° (1st 4.8°), 0.1°×0.1°(2nd 4.8°) 
Angular Accuracy ± 0.1° 
Frame Rate * 10 FPS  
# of Returns Up to 2 returns 
LASER 
Laser Safety Class Class 1 (IEC 60825-1: 2014) 
Laser Wavelength 1550 nm 
Beam Divergence (Full Angle) 0.1° 
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LIDAR OUTPUT 
Data transmission 1000Base-T1 Ethernet (UDP, TCP/IP) 
Points Per Second 1370,000 Points/sec @1 return 

2740,00 Points/sec @2 return 
Data Rate (Megabits Per Second) 11.69MB/S@1 return 

17.45MB/S@2 return 
Data Output radius, azimuth, reflectivity, timestamp, frame ID, return mode, working 

mode, fault state, CRC verification, etc. 
CONTROL INTERFACE 
Interface TCP and HTTP APIs 
Time Synchronization IEEE1588 (PTP), IEEE 802.1as(gPTP), NTP 
MECHANICAL/ELECTRICAL 
Power Consumption 20 W 
Operating Voltage 9 to 32V DC 
Standard Voltage 12V DC 
Connector Proprietary pluggable connector (Power + Automotive Ethernet + CAN) 
Dimensions (H×W×D) 58.9 mm × 228 mm × 149.6 mm 
Weight 1.7 kg 
Mounting 4×M4×18 screws, locating in bushings 
OPERATIONAL 
Operating Temperature -40 °C to +85 °C 
Storage Temperature -40 °C to +105 °C 
Ingress Protection IP67(body), IP69K(window) 
Shock IEC 60068-2-27  
Vibration IEC 60068-2-64 
ACCESSORIES 
Optional Wire Harness  5m cable (power & Ethernet) 
Optional Converter MetAdaptor 
Optional Mount Metal bracket 
SOFTWARE 
Available Drivers ROS/ROS2 

Note 

� If there are any changes to the specification table, please refer to the latest product manual. No separate 

notification will be provided. 

� Parameters marked with an "*" indicate that customization is available. If you have customization needs, 

please contact Seyond staff. 
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2 Installation 
2.1 Installation Precautions 
The Falcon K2 is generally installed on vehicles. Please observe the following precautions during installation. 
Personnel Requirements 

Installation must be performed only by qualified and trained professionals. 

Installation 
• If any component is damaged or missing, contact Seyond technical support for assistance.  
• Ensure the mounting surface is flat and stable.  
• Ensure that the LiDAR cables maintain an appropriate amount of slack to prevent tension or stress on the 

connector.   
• Reserve at least 8 cm of clearance at the connector for wiring.  
• Before installation, ensure the LiDAR’s Field of View (FOV) is not obstructed.  

o Default vertical FOV: –13° to +12°   
o Default horizontal FOV: –60° to +60° 

Storage 
• Store the product in a well-ventilated, dry environment. 

Recommended storage temperature: -40°C to +105°C, with humidity below 85%. 
• Do not immerse the product in water or operate it under harsh environmental conditions beyond its ingress 

protection rating. 
Avoid exposure to environments exceeding the specified IP rating. 

Transportation 

• Use the original shipping box with protective cushioning materials to prevent damage during transportation. 
• Handle the product carefully; do not drop or impact the device to avoid misalignment or optical damage. 
• Consider using lifting tools or assistance to minimize handling distance and avoid strain or impact.  
• Do not place the unit on unstable surfaces or carry it in an unsafe posture to prevent personal injury or 

equipment damage. 

Disposal of Packaging Materials 

 

� Packaging materials are recyclable. Please dispose of them correctly when 
discarding. 
□ Packaging bags, cartons, or plastic films should be kept out of reach of infants and 
children to avoid injury or suffocation. 
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2.2 Installation Instructions 
Power Supply Description 

The Falcon K2 LiDAR operates within a voltage range of 9–32 VDC, with a recommended supply 
voltage of 12 V. Under normal operating conditions, the LiDAR’s typical power 
consumption is approximately 20 W. 

Installation Dimensions 

 
（Unit：mm） 

Front View 
 

 
（Unit：mm） 

Top View 

2.3 Installation Method 
The LiDAR is mounted to the vehicle using four mounting ears, each equipped with a secondary vibration-
damping ring. The LiDAR is secured to the vehicle body with bolts and further isolated using soft rubber damping 
rings to minimize vibration and mechanical shock.  
During installation, users should reserve adequate operating space according to the vehicle layout and assembly 

削除: The operating voltage range of Falcon is 9 to 32 
VDC. It is recommended to use standard 12 VDC for the 
power supply. The power consumption of LiDAR is 
about 20W during regular operating.
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process.  

 
Cable Description 

 
 

Table 3 Cable Interface Description 

Serial Number Name Description 

1 LiDAR interface 

8-pin interface, pin definitions are as follows: 

 
[1]: Power- 
[2]: Empty pin 
[3]: Shield grounding 
[4]: Power + 
[5]: CAN high 
[6]: CAN low 
[7] and [8]: Gigabit Ethernet 

2 Power supply 4-pin interface, pin definitions are as follows: 

削除: The LiDAR is installed on the vehicle through 4 lugs, 
each equipped with a secondary bushing for damping. The 
LiDAR is fixed to the vehicle through the screws and 
damped by the bushings.

削除: During installation, users need to reserve 
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section 2.2.2 Installation Dimensions. Before installation, 
it is essential to reserve sufficient space according to the 
vehicle condition and installation craft. Refer to the lugs’ 
size and relative positions to the LiDAR in 2.2.2 Installation 
Dimensions. The installation method is shown below.
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Serial Number Name Description 

 
[1]: Power- 
[2]: Empty pin 
[3]: Power+ 
[4]: Empty pin 

3 
1000Base-T1 
automotive 
Ethernet 

1000Base-T1 Automotive Ethernet, pin definitions are as follows: 

 
[1] :Ethernet signal transmit 
[2] :Ethernet signal receive 

4 Grounding Shield grounding 

 

書式付きの表

削除:  

削除:  

削除:  

削除:  



Falcon K2 LiDAR User Manual 

Copyright©Seyond, Inc.  15  

Cable Connection 

 

2.4 Cleaning 
To ensure optimal performance, regularly check the LiDAR optical window and keep it clean. Follow the steps 
below to properly clean the optical surface: 
1. Prepare a clean, lint-free cloth, moisten it with alcohol, and wring it dry. 
2. Gently apply the damp cloth to the LiDAR window for about one minute to soften any contamination. 

  
3. After one minute, use a clean lint-free cloth to gently remove any dirt or stains, then dry the surface. 
4. Wipe the window clean with high-quality tissue or lens paper. Do not apply excessive pressure, as this 

may damage the optical coating.. 

Note 

Please wash your hands or wear PVC powder-free clean gloves before touching the product. 

Do not use solvents since they may damage the window coating. 

Please use a new dust-free wiper to wipe the LiDAR window. 

The LiDAR window is made of special plastic material. Please pay attention to the following items when cleaning: 

� Avoid direct skin contact with the optical window.  

� Do not use corrosive cleaners and solvents.  

� Do not use paper towels to clean the window to avoid scratches. 

LiDAR Window 
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3 Software Operation 
LiDAR operation is supported on the following platforms. For how to operate LiDAR using SDK-related tools, please 
contact Seyond staff to obtain related manuals. 

Table 1 platform instructions 

NO. Software Interface Description 

1 ILA 

ILA is the quickest way to view live point clouds and record data. The ILA 
GUI can be accessed through a web browser (preferably Chrome) and does 
not require any SW installation. Running on Linux, Windows, or Mac OS, 
and does not require any SW installation.  ILA does not support the 
replaying of recorded data. 

2 ROS 

ROS (ROS1) drivers are available for Kinetic, Melodic and Noetic. Please 
notice that drivers for ROS Kinetic will be discontinued soon. 
ROS2 drivers are also available for Foxy Fitzroy, Galactic Geochelone, and 
Humble Hawksbill.  

3 MetaView 

The MetaView can be run from any Linux or Windows OS computer. It 
allows viewing of the live point cloud, data recording, and replaying 
recorded data. It is recommended to use MetaView as the application for 
evaluation of the Falcon point cloud. 

 

3.1 Operate on ILA  
The ILA operations in this chapter are based on the firmware version FW0182 (S30). 

Access 

Note 
It is recommended to use the Google Chrome browser to access the ILA webpage.  
Please ensure that the system is powered on:  the system has no physical power switch and becomes operational 
automatically upon power connection.. 

1. Confirm that the computer IP address is within the same subnet as the LiDAR IP address. 

2. Connect the computer to LiDAR and ensure the Ethernet connection. For the detailed connection, see 

cable connection. 

3. Open Chrome browser. Enter the LiDAR IP and port number <IP Address>: <PORT> in the address bar to 

access the ILA. 
Note 
The default LiDAR IP address is 172.168.1.10. The default ILA port is 8675. The default ILA login address is 
172.168.1.10:8675. 
It is recommended to check the access to the LiDAR IP address by using the ping command. The return value is 
shown in the figure below. 
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View the point cloud status of the LiDAR  

1. Directly view the status of the LiDAR point cloud in real-time on the View Stream.  
2. (Optional) Change the point of view and distance in which the point cloud data is displayed using the 

keyboard shortcuts and mouse.  

Click  to check the available keyboard shortcuts. 

 

Record LiDAR point cloud data  

It is possible to record LiDAR point cloud data in different formats. 

1. Go to View stream > Record data stream. 
2. Select the way to record the point cloud file. 

If Auto is selected, specify the size of file before recording. If Manual is selected, the recording will 
continue until Stop is clicked. 
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1. Select the file format and size of the data to be recorded. 
• Record a file in .pcd format. 

Select Pointcloud snapshot (.pcd) in Format. Enter the number of frames to be recorded in frame(s). 
The range is from 0 to 20. 

• Record a file in inno_pc format. 
Select Inno-pointcloud (.inno_pc) in Format. Enter the number of frames to be recorded in frame(s). 
inno_pc is a proprietary format of Seyond point cloud files and cannot be read by 3rd party 
software. The points in inno_pc files are in spherical coordinates. inno_pc is in the optimum 
compression. 

• Record a file in inno_pc_xyz format. 
Select Cartesian coordinates Pointcloud (.inno_pc_xyz) in Format. Enter the number of frames to be 
recorded in frame(s). The range is from 0 to 10. 
inno_pc_xyz is a proprietary format of Seyond point cloud files and cannot be read by 3rd party 
software. The points in inno_pc_xyz files are in Cartesian coordinates. inno_pc_xyz is in the less 
optimum compression compared to inno_pc. 

• Record a file in inno_raw format. 
In the [Format] dropdown menu, select Innovusion raw data (.inno_raw). In the [MiB] input box, 
specify the file size (range: 10–200 MiB).  

The .inno_raw format is a proprietary raw point cloud file format developed by Seyond. 
• To record a YAML format file. 

In the [Format] dropdown menu, select YAML file (.yaml). 
2. Click Start to record the file. If Manual is selected, click Stop to stop recording the file. 
Note 
Point cloud data recording starts immediately by default. 

削除: 
上へ移動 [1]: <#>Select the way to record the point cloud 
file.
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LiDAR configuration  
Go to View Stream > LiDAR Settings to check and configure LiDAR settings. 

 

3.1.1.1 Select return mode  

Configure the number and method of echo receptions for each laser emission. The Return Mode can be set to either 
Single Return or Dual Return. 
In Dual Return mode, two options are available: 

• 2 Strongest: The system outputs the strongest and second strongest echoes.   
• Strongest & Furthest: The system outputs the strongest and furthest echoes.  

By default, the system operates in Single Return mode. 

3.1.1.2 Select working Mode 

In the [Working Mode] section, select the desired operating mode of the LiDAR. The following four modes are 
available: 

• Standby: The laser, polygon, and galvo are inactive, while electronic components remain powered to allow 
quick switching to working mode.   

• Normal: Normal operating mode. 
• Calibration: Calibration mode. 
• Quiet: Quiet mode. In this mode, the operational noise level is reduced. 
Note 
Before changing the working modes, please contact Seyond technical staff for confirmation. 

 

 
 

Configure ROI  

1. Go to View Stream > LiDAR settings. 
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Enter the ROI region position.   
• ROI-horz defines the horizontal center position of the ROI region, with a range of –60° to +60°.   
• ROI-vert defines the vertical center position of the ROI region, with a range of –12.4° to +14.1° (the actual 

configurable range depends on the customer’s Scan Pattern).  
Both ROI-horz and ROI-vert are measured in degrees (°).   
• After changing the ROI center position, click Save.  
Upon power cycling, the LiDAR will automatically reset to the saved ROI center position. 

 Change the LiDAR IP address  

1. Go to Sensor Config > Network. 

 

2. The IP address, netmask address, and gateway address of the LiDAR can be modified according to user 
needs. Click Save to save the changes. 
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3. Select View Stream > LiDAR Settings. Click Reboot to reboot the LiDAR. 

 

4. The IP address will be reset after rebooting. Be sure to use the new IP address when logging into the ILA. 

 

Time synchronization 
Go to Sensor Config > Sensor Config.  
Falcon K2 supports PTP, gPTP and NTP time synchronization method. 
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3.1.1.3 PTP time synchronization  

PTP (Precision Time Protocol) is a high-precision time synchronization protocol designed to ensure accurate 
timestamp alignment between devices. Two synchronization methods are available: 

• Hardware Timestamp Synchronization 
Achieves sub-microsecond-level accuracy through hardware-level timing signals. 

• Software Timestamp Synchronization 
Achieves tens of microseconds accuracy using software-based time stamping. 

Configuration Procedure 
1. Change the physical interface for PTP time synchronization in ptp4l.service. 
2. Users should choose the appropriate timing method based on actual conditions and configure 

accordingly. Click save to save the settings. 
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Note 
PTP WL: PTP whitelist. PTP whitelist. Only the devices specified by the PTP whitelist can be the source clock in the 
PTP time synchronization. Any devices not in the whitelist cannot synchronize time with the LiDAR. The whitelist 
will take effect after powering off and on the LiDAR. 

3. Perform a reboot to enable the settings. Check if the time has been synchronized on Log File. 

3.1.1.4 gPTP time synchronization  

When using the gPTP (generalized Precision Time Protocol) synchronization mode, ensure that all network nodes 
and devices—from the time synchronization server to the LiDAR—support PTP time synchronization. 

The gPTP synchronization method includes two timestamp synchronization modes:   

• Hardware Timestamp Synchronization: Provides sub-microsecond accuracy.   
• Software Timestamp Synchronization: Provides tens of microseconds accuracy. 

Configuration Procedure 
1. Change the physical interface for PTP time synchronization in ptp4l.service. 
2. Users should choose the appropriate timing method based on actual conditions and configure 

accordingly. Click save to save the settings. 

 
Note 
PTP WL: PTP whitelist. PTP whitelist. Only the devices specified by the PTP whitelist can be the source clock in the 
PTP time synchronization. Any devices not in the whitelist cannot synchronize time with the LiDAR. The whitelist 
will take effect after powering off and on the LiDAR. 
3. Perform a reboot to enable the settings. Check if the time has been synchronized on Log File. 

 

 

3.1.1.5 NTP time synchronization  

Network Time Protocol (NTP) is a networking protocol for clock synchronization between computer systems over 

書式変更: inno-一级有序步骤, インデント : 左 :  0
mm, ぶら下げインデント :  4.42 字, 間隔 段落前 :  0
pt, 段落後 :  0 pt, タブ位置:  3.43 字(なし) 

削除: hard 

削除: of the LiDAR 

削除: 

書式を変更: フォント : (英) Microsoft YaHei

削除: Make sure that all network nodes support PTP time 
synchronization before adopting gPTP as the time 
synchronization mode. gPTP time synchronization is also 
divided into Hardware timestamp synchronization (sub-
microsecond accuracy) and Software timestamp 
synchronization (tens of microseconds accuracy).

書式変更: リスト段落, 間隔 段落前 :  3 pt, 段落後 :  3
pt, 箇条書き + レベル : 1 + 整列 :  6.3 mm + インデ
ント :  12.7 mm

書式を変更: フォント : 太字

書式変更: 標準, 間隔 段落前 :  3 pt, 段落後 :  3 pt

書式変更: 行間 :  1 行

削除: 

削除: 

書式変更: 行間 :  1 行

削除: hard 

削除: of the LiDAR 



Falcon K2 LiDAR User Manual 

Copyright©Seyond, Inc.  24  

packet-switched, variable-latency data networks (precision at few microseconds). 

1. Select NTP. Enter the IP address of the Master in NTP server IP. Click save to save the settings. 

 

2. Perform a reboot to enable the settings. Check if the time has been synchronized on Log File. 

View/download logs 
Users can view and download various types of log files to verify operation records and alarm information. 

1. Navigate to the [Log File] page. 
2. Select the type of log. Users can choose from ILA-f (web page related logs), Firmware, Pointcloud 

server, and UDS types of logs. 

 
3.  (Optional) Set the filtering criteria of the logs. 

• Time range: Select Prev boot or This boot to choose whether to display the last 100 log messages 
generated before this boot or those generated after this boot. 
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• Type of log: Select Issues only or Full log to choose whether to display only the problem or all logs. 
• Log level: Click Log level and select the log level to be displayed. The log level is described in the 

following table. 

4. Users can view the logs on the left side or click 【Download】 to download the corresponding log. 

Severity Level Description 

fatal Indicates a critical and unrecoverable error. Such errors cause the application to terminate. 

critical Represents an irreversible error that prevents the system from operating normally. 

error Indicates general errors or exceptions encountered during operation. 

temp Currently not in active use. 

warning Provides warning messages, indicating potential risks or abnormal conditions. 

debug Contains information useful for debugging the application. 

info Highlights general operational information during program execution. 

trace Outputs detailed messages for tracing program flow. 

detail Provides more detailed output than the trace level. 

verbose Outputs messages even more detailed than the trace level (used for deep analysis). 

exception Records exception-related information that occurs during execution. 

View version information  

Check the device serial number, hardware version, and SDK version information in the View Stream > Sensor values. 

 

System shutdown  

To shut down the system, disconnect the power supply.  

The system will power off automatically once the power is disconnected 
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3.2 Operate in ROS  
This section is specifically for Ubuntu 18.04 with ROS version melodic. 

Start the system 

1. Connect the power supply to start the LiDAR. 
2. The LiDAR completes initialization and generates data after powering on for 11 to 18 seconds. 
Note 
The LiDAR does not have a power switch. It will become operational when power is applied. 

Capture the point cloud data 

Note 
Ensure the system is powered on before starting the ROS driver. The ROS driver needs to be restarted after the 
LiDAR is shut down or the software is restarted. 
For instructions on installing the ROS environment, please refer to http://wiki.ros.org/ 
1. Confirm the computer IP address settled the same subnet as the LiDAR. 
2. Connect the computer to LiDAR and ensure the Ethernet connection. For the detailed connection, see 

cable connection. 
Note 
It is recommended to use the ping command to confirm smooth connectivity between the master control and the 
LiDAR, with a return value as shown. 

 
3. View the system details and obtain the corresponding driver. Copy the driver to the root directory of the 

system. Execute the following command to install the driver. 
sudo dpkg -i <package.deb> 

Note 
In this step, package.deb refers to the name of the LiDAR driver package. Please obtain the latest version of the 
driver according to your requirements. 
To acquire the appropriate driver package, please contact your Seyond technical support staff. 

Table 5 System Version Support 

System Version CPU Category Support Status 

Ubuntu 18.0.4 
ARM Supported 

X86 Supported 

Ubuntu 20.0.4 
ARM Supported 

X86 Supported 

4. Run ROS. The return value when the driver is installed correctly is shown in the figure. 
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roscore 

 
Note 
If any abnormalities occur while acquiring data through ROS1 or ROS2, try executing the following command 
before retrieving data again: 
source /opt/ros/<distro>/setup.bash 

5. Start the ROS1 driver to acquire LiDAR data.  
//View and acquire the live point cloud data via the UDP port (default) 
roslaunch seyond start.launch lidar_ip:=172.168.1.10 udp_port:=8010 
//View and acquire the live point cloud data via the UDP port (default) 
roslaunch seyond start.launch lidar_ip:=172.168.1.10 tcp_port:= 8010 
//Packet mode 
roslaunch seyond start.launch lidar_ip:=172.168.1.10 udp_port:=8010 packet_mode:=true  
 

Note 
Default LiDAR_ip Address is 172.168.1.10. Default UDP_port and tcp_port are 8010. 
 
Note 
In packet mode, data is published to the /iv_packets topic in inno_pc format.  
The stored data occupies approximately one-fourth of the memory size compared to data stored from the 
/iv_points topic.  
However, this data format requires Seyond’s proprietary ROS driver for playback.  
For playback instructions, refer to the section “Replaying PCAP Files.” 
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View LiDAR point cloud status 

Note 
Before checking the LiDAR point cloud status, please ensure that point cloud data has been successfully acquired. 

1. Run the graphical tool rviz. The rviz client will open. 

rviz -f seyond 

 

2. Add and adjust PointCloud2. 

i. Add PointCloud2 to the Displays. 
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a. Click Add. 

b. Select [By topic] > [iv_points] > [PointCloud2] 

c. Click OK. 

 

ii. Select PointCloud2 > Topic , change the Topic value to /iv_points.  

iii. Select PointCloud2 > Style , change the Style value to Points. 

 
 

削除: .
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Note 
For multi-LiDAR configurations, you need to add multiple PointCloud2 nodes, with each node’s topic name 
corresponding to the configured LiDAR frame_topic 

3.  (Optional) It is possible to change the angle and distance of the real-time point cloud status to get more 

information as needed. 

• Add Axes to display the coordinate system to the diagram as a reference. 

a. Select Add > By display type > Axes. 

b. Click OK to add Axes. 

c. Check Axes to display the coordinate system. 

 

• Select Grid to add the grid to the diagram as a reference. Grid is enabled by default when rviz is 

started. 

• Set the plane value to view the point cloud status under different coordinate systems. The Plane 

options are XY, XZ, and YZ. 
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Record LiDAR point cloud data 

Users can record LiDAR point cloud data in .bag format within the ROS environment. 

Note 
Before recording the point cloud data of the LiDAR, please ensure that point cloud data has been correctly 
acquired through ROS.  
For detailed instructions on how to acquire point cloud data, refer obtaining point cloud data. 
1. Execute the following command to record point cloud data in .bag format. Recording starts from the 

execution time. 

rosbag record /iv_points -o inno // Starts recording point cloud data in the current directory, file 

named "inno-Yr-Mo-Dy-Hr-Min-Sec.bag"。 

 
2. Press Ctrl+C to stop recording the point cloud data. 
3.  (Optional) Execute the ls -a command to check the directory of recorded point cloud data. 
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Replay LiDAR point cloud data  

Users can replay LiDAR point cloud data files in .bag format through the ROS environment. 

Note 
Before replaying LiDAR point cloud data, please confirm that the recorded point cloud data file has been 
obtained. 

1. Run ROS. The return value when the driver is installed correctly is shown in the image. 

roscore 

2. Run the graphical tool rviz. 

Rviz -f seyond 

3. Replay LiDAR point cloud data in rviz. 

rosbag play <filename.bag> 

4. in RViz, select the corresponding point cloud for visualization. 

5. Adjust parameters in PointCloud2. 

i. Add PointCloud2 to the Displays. 

a. Select Add > By display type > PointCloud2. 

b. Click OK. 

 

ii. Select PointCloud2 >Topic , change the Topic value to /iv_points. 

削除: Replay the point cloud data in bag format in ROS 
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iii. Select PointCloud2 > Style, change the Style value to Points. 

 

6.  (Optional) It is possible to change the angle and distance of the real-time point cloud status to get more 

information as needed. 

• Select Axes to add the coordinate system to the diagram as a reference. 

a. Select Add > By display type > Axes. 

b. Click OK to add Axes. 
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• Select Grid to add the grid to the diagram as a reference. Grid is enabled by default when rviz is 

started. 

• Set the plane value to view the point cloud status under different coordinate systems. The available 

Plane values are XY, XZ, and YZ. 

 

7. Press Space to pause playback of the point cloud data file. 
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Configure reflectance mode 

Note 
Before recording the point cloud data of the LiDAR, please confirm that the point cloud data has been obtained 
correctly in ROS.  
 

roslaunch innovusion_pointcloud innovusion_points.launch reflectance_mode:=<true/false> 
[Parameter description] 

reflectance_mode： The LiDAR's reflectance mode. The value for reflectance mode can be either true or false. 

Ø A value of false means that the reflectance mode of the LiDAR is selected as intensity. The return value in 

intensity mode is the echo read directly by LiDAR. The intensity varies with the influence of the factors including 

object distance, object reflectivity, beam angle, etc. 

Ø A value of true means that the reflectance mode of the LiDAR is selected as reflectivity. The return value in 

reflectivity mode is the calculated result based on the intensity and rectified with the object distance, beam 

angle and other parameters. 

 
 

Configure the return mode 

Note 
Before recording the point cloud data of the LiDAR, please confirm that the point cloud data has been obtained 
correctly in ROS.  
 

roslaunch innovusion_pointcloud innovusion_points.launch multiple_return:=<return_mode> 
[Parameter description] 
multiple_return: the echo received when a laser is emitted once. 

• A default value of 1 means the single return mode. 

• A value of 2 means the strongest + 2 strongest return mode.  

• A value of 3 means the strongest & furthest return mode. 
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 (Optional) Convert a file in rosbag format to a file in pcd format  

1. Run ROS. The return value is shown in the figure below. 

roscore 

 

2. Convert a .bag format file to a .pcd format file. 

rosrun pcl_ros pointcloud_to_pcd input:=/iv_points 

3. Play a .bag format file. 

rosbag play <filename.bag> 

書式変更: inno-图片

削除: 

書式変更: inno-示例

削除: 



Falcon K2 LiDAR User Manual 

Copyright©Seyond, Inc.  37  

Shut down the LiDAR 

To shut down the system, disconnect the power supply. The system will power off automatically once the power is 
disconnected. 
  

削除: Disconnect the power supply to shut down the LiDAR
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3.3 Operate in ROS2 environment  
The operations described in this chapter apply only to Ubuntu 20.04 with ROS Foxy. 
Capture the point cloud data 

Note 
Ensure the system is powered on before starting the ROS driver. 
The ROS driver needs to be restarted after the LiDAR is shut down or the software is restarted. 
For instructions on installing the ROS environment, please refer to http://wiki.ros.org/ 

1. Ensure the computer IP address to the same subnet with the LiDAR. 
2. Connect the computer to LiDAR and ensure the Ethernet connection. For the detailed connection, see 

cable connection. 
Note 
It is recommended to use the ping command to confirm smooth connectivity between the master control and the 
LiDAR, with a return value as shown. 

 

3. View the system details and obtain the corresponding driver. Copy the driver to the root directory of 

the system. Execute the following command to install the driver. 
sudo dpkg -i <package.deb> 

 

Note 
In this step, package.deb refers to the name of the LiDAR driver package. Please obtain the latest version of the 
driver according to your requirements. 
To acquire the appropriate driver package, please contact your Seyond technical support staff. 

Table 5 System Version Support Status 

System Version CPU Category Support Status 

Ubuntu 20.0.4 
ARM Supported 
X86 Supported 
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System Version CPU Category Support Status 

Ubuntu 22.0.4 
ARM Supported 
X86 Supported 

4. Capture LiDAR point cloud. 
//Capture the point cloud data via UDP (default with UDP mode, udp_port:=8010) 

  ros2 launch seyond_start.py lidar_ip:=<device_ip> udp_port:=<UDP_port> 
example: 
ros2 launch seyond start.py lidar_ip:=172.168.1.10 udp_port:=8010 

//Capture the point cloud data via TCP (not recommended) 
  ros2 launch seyond_start.py lidar_ip:=<device_ip> port:=<TCP_port> 

example: 
ros2 launch seyond start.py lidar_ip:=172.168.1.10 tcp_port:=8010  

//packet mode 
  ros2 launch seyond start.py packet_mode:=true  
Note 
The default device_ip is 172.168.1.10. The default TCP_port and UDP_port is 8010. 

View LiDAR point cloud data  
Note 
Before viewing the point cloud data, please confirm that the point cloud data has been obtained. 
1. Execute the rviz2 command to launch the graphical visualization tool RViz in ROS2. After execution, the 

following output appears, indicating that the RViz client has been successfully opened. 
rviz2 -f seyond 

 
2. Add and adjust PointCloud2. 

i. Add PointCloud2 to the Displays. 
a. Click Add. 
b. Select By display topic > PointCloud2. 
c. Click OK. 
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ii. Select PointCloud2 > Topic , change the Topic value to /iv_points. 

iii. Select PointCloud2 > Style, change the Style value to Points. 

 
3.  (Optional) It is possible to change the angle and distance of the real-time point cloud status to get more 

information as needed. 
• Select Axes to add the coordinate system to the diagram as a reference. 

a. Select Add > By display type > Axes.  
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b. Click OK to add Axes. 

 

• Select Grid to add the grid to the diagram as a reference. Grid is enabled by default when rviz is 

started. 
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• Set the plane value to view the point cloud status under different coordinate systems. There are 

three options: XY, XZ, and YZ. 

 
 

Replay LiDAR point cloud data  

It is possible to replay the point cloud data in pcap format in ROS environment. 

Note 
Before replaying LiDAR point cloud data, please ensure that a recorded point cloud data file is available. 

1.  Open a new terminal window and execute the rviz to launch the graphical visualization tool RViz in ROS.. 
rviz2 -f seyond 

 

 
2. Open a new terminal window and execute the following command to replay the LiDAR point cloud data 

in RViz. 
ros2 bag play <bag-file> -l 
 

3. in RViz, select the corresponding point cloud for visualization. For detailed instructions, refer to the 
section “Viewing LiDAR Point Cloud Status.” 
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Ø device_ip: The IP address of the LiDAR from which the data was captured. 

Ø pcap_file: The file name to be replayed. 

Ø UDP port: The UDP port of the LiDAR from which the data was captured.  

Ø packet_rate(Optional): The replay speed of the file. The default value is 20.  

• When the play_rate=0, the play speed is as fast as possible. 
• When the play_rate≤100, the unit of play speed is MB/s. e.g., When play_rate=50. the play speed 

is at 50 MB/s. 
• When the play_rate>100, the play speed=play_rate/10000.0. e.g., When play_rate=15000. the 

play speed is at 1.5 times. 

Ø file_rewind(Optional): The number of times file is replayed.  

• A default value of 0 means no repeat.  
• A negative value means the file will be repeated indefinitely until the program is manually 

stopped. 

4. Select Global Options > Fixed Frames, change the value to innovusion. 

 

5. Adjust parameters in PointCloud2. 

i. Add PointCloud2 to the Display. 
a. Select Add > By display type > PointCloud2. 
b. Click OK. 
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ii. Select PointCloud2 > Topic, change the Topic value to /iv_points. 

 

iii. Select PointCloud2 > Style , change the Style value to Points. 
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6. (Optional) It is possible to change the angle and distance of the real-time point cloud status to get more 

information as needed. 
• Select Axes to add the coordinate system to the diagram as a reference. 

a. Select Add > By display type > Axes.  
b. Click OK to add Axes. 
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• Select Grid to add the grid to the diagram as a reference. Grid is enabled by default when rviz is 
started. 

 
• Set the plane value to view the point cloud status under different coordinate systems. The Plane 

options are XY, XZ, and YZ. 

 

7. Press Space to pause playback of the point cloud data file. 
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Convert the reference coordinates of the displayed point cloud  

Note 
Before viewing the point cloud data, please confirm that the point cloud data can be obtained correctly.  

ros2 run innovusion publisher --ros-args -p coordinate_mode:=<select_mode> 
[Parameter description] 
coordinate_mode: The reference coordinates of the displayed point cloud, ranging from 0 to 4. A default value of 0 
means that the X-axis is pointing up, the Y-axis is pointing right, and the Z-axis is pointing forward, see section 1.4 
Structural Description for details. 

• A value of 1 means the X-axis points to the right, the Y-axis forwards, and the Z-axis upwards. 
• A value of 2 means the X-axis points to the right, the Y-axis upwards, and the Z-axis forwards. 
• A value of 3 means the X-axis points forwards, the Y-axis to the right (reversed), and the Z-axis 

upwards. 
• A value of 4 means the X-axis points forwards, the Y-axis upwards, and the Z-axis to the right. 

 

Configure the reflectance mode  

Before configuring the reflectance mode, please ensure that the point cloud data has been correctly obtained. For 
information on how to obtain point cloud data, refer to section 3.3.1 Obtain Point Cloud Data. 

ros2 run innovusion publisher --ros-args -p reflectance_mode:=<reflectance_mode> 
[Parameter description] 
reflectance_mode: reflectance mode of the LiDAR. The value of reflectance mode can be either false or true. 

• A value of false means that the reflectance mode of the LiDAR is selected as intensity. The return 
value in intensity mode is the echo read directly by LiDAR. The intensity varies with the influence of 
the factors including object distance, object reflectivity, beam angle, etc. 
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• A value of true means that the reflectance mode of the LiDAR is selected as reflectivity. The return 
value in reflectivity mode is the calculated result based on the intensity and rectified with the object 
distance, beam angle and other parameters. 

 

Configure the return mode  

Before configuring the echo mode, please ensure that the point cloud data has been correctly obtained. For 
information on how to obtain point cloud data, refer to section 3.3.1 Obtain Point Cloud Data. 

ros2 run innovusion publisher --ros-args -p multiple_return:=<return_mode> 
[Parameter description] 
multiple_return: the echo received when a laser is emitted once. 

• A default value of 1 means the single return mode. 
• A value of 2 means the strongest + 2 strongest return mode.  
• A value of 3 means the strongest & furthest return mode.  
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Change the distance limitation for the displayed point cloud  

Note 
Before changing the distance limit of the point cloud data, please ensure that the point cloud data has been 
correctly obtained. For information on how to obtain point cloud data, refer to section 3.3.1 Obtain Point Cloud 
Data. 

ros2 run innovusion publisher --ros-args -p max_range:=<max_distance> -p min_range:=<min_distance> 
[Parameter description] 

• max_range: The maximum distance of the displayed point cloud in meter, up to 2000.0. 
• min_range: The minimum distance of the displayed point cloud in meter, down to 0.4. 

 

Shut down the LiDAR 

To shut down the system, disconnect the power supply.  

The system will power off automatically once the power is disconnected. 
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3.4 Operate on MetaView 
MetaView is a specified software that provides viewing, recording, and replaying point cloud and other functions to 
help optimize usage for your Seyond LiDAR. MetaView can be run on multiple operating systems including Linux, 
MacOS and Windows. This chapter takes operations on Windows as an example.  

The MetaView operations in this chapter are based on the 1.5.1 version. 

Start the System 
1. Connect the power supply to start the LiDAR. 

2. The LiDAR completes initialization and generates data after powering on for 11 to 18 seconds. 

Note 
The LiDAR does not have a power switch. It will become operational when power is applied. 
 

Get started 

Unzip the MetaView package. Double-click to start MetaView. 

 

 
 

Main interface 

1. The main interface of MetaView can be divided into three functional areas: 

• The bottom right corner is the quick function button area for invoking features. 

• The bottom left corner shows the basic information and color spectrum control area. 

• The center of the screen is the point cloud display area and the functional window display area. 
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2. Upon first run, you can choose to execute the automatic performance test feature, which will 

automatically adjust the settings of MetaView. 

 

3. After completing the performance adjustments, the first-time user tutorial will be automatically 

triggered. Users can choose to follow the tutorial to complete the beginner's guide, or close the tutorial. 

The tutorial can be manually reopened later. 
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Basic operations 

You can perform all functions through the most basic MetaView operations. 

3.4.1.1 Control viewport 

1. Keyboard function: You can control the angle of the view via the keyboard. 

• Hold the W / A / S / D keys to move forward, left, backward, and right, respectively. 
• Hold the Q / E keys to move vertically up and down. 

• Hold the ↑  ↓  ←  → keys to rotate the view. 

2. Mouse function: It is strongly recommended to use a combination of keyboard and mouse to control the 

angle of the view for the best operating experience. 

• Hold the left mouse button and drag to rotate the view. 
• Hold the middle mouse button and drag to pan the view. 
• Hold the right mouse button and drag forward or backward to zoom in or out. 

Note 
You can increase the moving speed by holding the left Shift key while using the above key combinations. 

3.4.1.2 Shortcuts 

In MetaView, you can use the following shortcuts to enhance your experience. 
1. Show the specified Point Cloud Data 

Hold the Z key while drag the left mouse button to select a point cloud area. Release the left mouse 
button when done selecting to automatically calculate the point cloud information for the selected area, 
which is very useful for gaining a deeper understanding of the point cloud data. 

2. Data Play/Pause 
Press the Spacebar to quickly pause/resume playback while playing online point clouds or replaying 
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local point cloud data. 
3. Toggle LiDAR View 

Press the Y key to immediately switch to the LiDAR view between the actual view of angle and the 
default view. 

Note 

You can always click the third-last keyboard icon "  " to view the keyboard layout diagram; everything you want 
to know is right there. 

 

Connect to LiDAR 
Let's get started with connecting to the LiDAR; please ensure that your computer and LiDAR are on the same network 
segment. 

1. Click  in the bottom right corner to open the LiDAR Network Control Panel. 
2. The default LiDAR IP is 172.168.1.10 and the port is 8010 by default. However, if the LiDAR is not set to 

default settings and you need to change the target IP or port, please turn off the connection switch 
before making any changes. 

3. We strongly recommend using the default UDP method to connect to the LiDAR for the best connection 
experience. When dealing with some specific point frequency LiDARs or special scanning modes, 
connecting via TCP or WebSocket may result in poor performance. 
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Note 
Please refer to this document for troubleshooting possible issues during the connection process: UDP Connection 
Diagnostics.  

Radial Grid 

This feature provides a simple circular distance grid for displaying point cloud data at near and far distances. 

Click the to open the control window. 

 
Ø Grid Interval 

Controls the interval between each grid line. 
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Ø Distance Limit 

Controls the maximum distance of the grid. 

Ø Grid Fluctuate 

Controls the vertical positioning of the grid. 

Ø Grid Alpha 

Controls the transparency of the grid. 

Ø Grid Size 

Controls the thickness of the grid lines. 

Ø Font Size 

Controls the font size of the distance text on the grid. 

Ø Grid Slope 

Controls the vertical rotation of the grid. 

Ø Grid Rotation 

Controls the horizontal rotation of the grid. 

Ø Grid Switch 

Toggles the grid on or off. 

Ø Mark Up/Down 

Controls whether the text floats above the grid. 
 

Data Playback 

The local file system includes two modules: local file playback and local file format conversion. It supports playback 
of files in formats like inno_pc, inno_pc_xyz, pcd (binary/ASCII), pcap, bag, csv, and record, but does not support 
playback of raw formats. 

3.4.1.3 Local File Player 

The local file player is a point cloud playback tool similar to a video player. Like a video player, it also has features 
such as file selection, play/pause/resume/stop, previous/next frame, speed control, progress dragging (not 
supported for ASCII PCD format), and total frames display. 

Click  to open the control window. 
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1. Click the folder icon  on the left, and the system file picker will automatically pop up. Select the point 
cloud file you want to play, and it will start playing. 

2. If you see an important point cloud frame and wish to save it for analysis, you can pause the playback and 

then click the PCD file icon . This way, you can obtain the PCD file of that particular point cloud frame. 

 
 

Data Recording 

Data recording allows you to quickly record a specified length of LiDAR point cloud data. 

Click to open the control window. 
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1. Recording is divided into two modes. 

• The default is By Viewer mode, which uses built-in tools to record data. It has strong LiDAR 

compatibility, but limited format support. 

• The other is By LiDAR mode, which saves the LiDAR data directly. This mode has weaker LiDAR 

compatibility, but supports more formats. 
Note 
Please connect to the LiDAR before recording. You can set up the connection by clicking on the network settings 
button in the lower right corner of the function area. 

2. Once the setup is complete, click the record button  to start recording. 

3. After recording is completed, you can click  to open the file save directory. 
 

UDP Connection Diagnostics 

When using UDP to connect to the LiDAR, especially during the initial connection, MetaView may not be able to 

retrieve LiDAR data due to some specific reasons. You can use this feature for testing and verification. 

Click  to open the control window. 
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3.4.1.4 IP connection diagnose 

IP connection diagnose is used to confirm whether the target device's IP address is connecting properly. By using 
the ping command, you can determine if the network connection is properly and check for any delays. 
Troubleshooting suggestions: 
1. Check Network Connection 

• Ensure that the computer's Ethernet cable is correctly connected, or that the wireless network is 

connected to the correct SSID. 

• Check if network devices (such as switches, routers) are functioning properly. 
2. Check IP Address Configuration 

• Ensure that the computer's IP address is configured correctly. You can use the ipconfig (Windows) 

or ifconfig (Linux/Mac) commands to view the current IP configuration. 

• Ensure there are no IP address conflicts, meaning no other devices on the network are using the 

same IP address. 
3. Check LiDAR Device Status 

• Ensure the target LiDAR is powered on and connected to the network. 

• Check if the device's network interface is working properly. 

3.4.1.5 Firewall Testing 

Firewall Testing is used to confirm whether a firewall is blocking necessary network communications. An enabled 

firewall may block communication on certain ports or protocols, affecting the normal operation of the device, and 

result disconnection between the SDK and the LiDAR. 
Note 
This issue is common on strictly managed Windows devices. For security-sensitive Linux/Mac users, you may opt 
not to enter a sudo password to skip this check. 



Falcon K2 LiDAR User Manual 

Copyright©Seyond, Inc.  59  

 
Troubleshooting suggestions: 

1. Windows 

i. Check Firewall Status 

a. Open Control Panel > System and Security > Windows Defender Firewall. 

b. Ensure the firewall is turned off, and check for any blocking rules. 

ii. Allow Applications through the Firewall 

a. In Windows Defender Firewall, click on Allow an app or feature through Windows Defender Firewall. 

b. Check and ensure that necessary applications are allowed. 

iii. Create Inbound/Outbound Rules 

a. In Advanced Settings, create new inbound or outbound rules to allow specific ports or programs 

through the firewall. 

iv. Temporarily Disable Firewall for Testing 

a. In Windows Defender Firewall, select Turn Windows Defender Firewall on or off to temporarily disable 

the firewall for testing. 

2. Linux 

i. Check Firewall Status (using iptables or firewalld) 

a. Use sudo iptables -L to view current iptables rules. 

b. For firewalld, use sudo firewall-cmd --state to check the status. 

ii. Add Firewall Rules 

a. Use sudo iptables -A INPUT -p tcp --dport 80 -j ACCEPT to allow a specific port. 

b. For firewalld, use sudo firewall-cmd --add-port=80/tcp --permanent to add a rule, then sudo firewall-

cmd --reload to reload the configuration. 

iii. Temporarily Disable Firewall for Testing 

a. Use sudo systemctl stop firewalld or sudo systemctl stop iptables to stop the firewall. 

3. Mac 

i. Check Firewall Status 

a. Open System Preferences > Security & Privacy > Firewall. 

b. Ensure the firewall is turned off. 

ii. Allow Applications through the Firewall 

a. In the Firewall tab, click Firewall Options to add or remove allowed applications. 
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iii. Manage Firewall via Command Line 

a. Use sudo /usr/libexec/ApplicationFirewall/socketfilterfw --add /path/to/app to allow a specific 

application. 

iv. Temporarily Disable Firewall for Testing 

a. Use sudo /usr/libexec/ApplicationFirewall/socketfilterfw --setglobalstate off to turn off the firewall. 

3.4.1.6 VLAN Testing 

Some LiDAR devices come with VLAN functionality enabled by default, which may prevent the SDK from receiving 
data packets sent by the LiDAR, thereby making it impossible to display the point cloud. 
Troubleshooting suggestions: 
If this item displays abnormally, you can resolve it using the command echo set_i_config network vlan 0 | nc -
nv YOUR_IP_ADDRESS 8002 -w 1 in the command line or terminal. Note that you need to restart the LiDAR to 
apply the settings after executing the command. 

3.4.1.7 Network Mode Testing 

Issues with multicast and broadcast are often due to a mismatch or lack of support in the local environment or 
network device configurations on the LiDAR side, preventing the host computer from receiving packets from the 
LiDAR. 
Troubleshooting suggestions: 

1. Broadcast Mode 

• Check if the LiDAR is configured in broadcast mode and is on the same subnet with the host 

computer. 

• Check if network devices (such as switches, routers) support broadcasting and are not blocking 

broadcast traffic. 

2. Multicast Mode 

• If the LiDAR is configured in multicast mode, check that the multicast address is within the valid 

range (224.0.0.0 to 239.255.255.255). 

• Ensure network devices support multicast and have IGMP (Internet Group Management Protocol) 

enabled to manage multicast groups. 

3. Unicast Mode 

• Ensure that the LiDAR’s unicast address matches the IP address of the host computer. 

• Check the subnet masks of the LiDAR and the host computer to ensure they are on the same 

subnet. 

• Ensure that network devices are not blocking unicast traffic. 

3.4.1.8 SDK Library Testing 

Check for older versions of SDK in the system libraries to confirm potential version conflicts. Older SDK libraries may 
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be incompatible with newer versions, causing functional anomalies or crashes. 
Troubleshooting suggestions: 
For Linux/Mac versions, if this issue arises, check the usr/lib or usr/local/lib folders for files starting with 
libinnolidar. If they exist, delete them and restart MetaView. 

3.4.1.9 Dual IP Testing 

As the LiDAR may have multiple connectable IPs, dual IP testing is used to confirm whether the current connection 
IP is the UDP IP. Typically, LiDAR has only one dedicated UDP sending IP, which defaults to 172.168.1.10. 
Troubleshooting suggestions: 

You can try clicking the diagnostic output button  to view the diagnostic log file 
DiagnosticLog.txt. The field "LiDAR UDP Output IP" is indicates the LiDAR UDP IP. 

3.4.1.10 Network Stability Monitoring 

Once successfully connected, the diagnostic tool will continue to perform additional data monitoring to diagnose 
network stability. This check updates approximately every 30 seconds. Under normal conditions, the packet loss rate 
should be 0%. If the network environment is poor, this value may slightly increase. If the value is significantly high, 
please check the status of the network environment. 

Color Configuration 

Color configuration allows users to adjust the color of the point cloud based on different point cloud attributes or 

coloring needs. 

3.4.1.11 Color Range Adjustment 

This is the point cloud color preview area . From left to right, it represents the point 

cloud attribute values from low to high. You can click here to open the color configuration panel or hover your 

mouse over this area to view  the color information. 

 
Color Mode includes five color modes and three rendering modes. The colors in fixed Gradient mode and Fixed Solid 
Color mode are preset, whereas the Custom Gradient mode and Custom Multi-type mode allow for customizable 
color schemes. Users can highly customize the coloring of the point cloud through this panel. 

1. Color Modes 

• Fixed Gradient Mode: Uses preset gradient colors to color the point cloud. 

書式変更: 行間 :  1 行



Falcon K2 LiDAR User Manual 

Copyright©Seyond, Inc.  62  

• Custom Gradient Mode: Uses highly customizable gradient colors to color the point cloud. 

• Fixed Solid Color Mode: Uses preset solid color gradients to color the point cloud. 

• Custom Multi-type Mode: Special mode, requires custom point cloud files, not recommended for 

non-specific business use. 

• Camera Render Mode: Special mode, requires a network camera, not recommended for non-

specific business use. 

2. Color Schemes 
Note 
After selecting a color or gradient, don't forget to click the "confirm" button. 

• Fixed Gradient Mode: Offers 110+ preset gradient colors. 

• Custom Gradient Mode: You can change the desired color by clicking the color bar to open the color 

picker. 

 

a. In the gradient editor, left-click below the gradient bar to add a gradient marker. Right-click on a 

gradient marker to delete it. 

b. In the gradient editor, drag the gradient markers and place them wherever you want, the gradient bar 

will adjust according to your settings. 

c. In the gradient editor, left-click on a gradient marker to select its color, then left-click the color button 

below to view the color editor panel. 
 

 

d. In the color editor, you can select your preferred color like any other color picker or directly enter Hex 

codes to select a color. 
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• Fixed Solid Color Mode: Provides 30+ preset black to solid color gradients. 

• Custom Multi-type Mode: Special mode, requires custom point cloud files, not recommended for 

non-specific business use. 
Note 
Defining multi-type mode only provides color configurations for specific data sources recognized by AI. Each 
object type has a unique color type. Click the numbers to modify the color of the corresponding type. 

• Camera Mode: ※Special mode requires connecting to a network camera, not recommended for 

non-specific business use. 

3. Rendering Modes 

• Reflectivity Coloring Mode: The system will try to find the reflectivity field of the current point cloud 

to color it. 

• Intensity Coloring Mode: The system will try to find the intensity field of the current point cloud to 

color it. 

• Distance Coloring Mode: The shader will cyclically color the point cloud based on the distance of 

each point from the origin. 

• Channel Mode: The shader uses a uniform red-blue RGB gradient template to color the point cloud 

based on channel information and upper/lower limits. 

• Scan Line Mode: The shader uses a uniform red-blue RGB gradient template to color the point cloud 

based on scan line information and upper/lower limits. 

• Index Mode: The shader uses a uniform red-blue RGB gradient template to color the point cloud 

based on index information and upper/lower limits. 

• Region of Interest (ROI) Mode: The shader uses a uniform red-blue RGB gradient template to color 

the point cloud based on ROI information and upper/lower limits. 

• Facet Mode: The shader uses a uniform red-blue RGB gradient template to color the point cloud 

based on face information and upper/lower limits. 

• Topic Number Mode: The shader uses a uniform red-blue RGB gradient template to color the point 

cloud based on topic information and upper/lower limits. 

• Multiple Returns Mode: The shader uses a uniform red-blue RGB gradient template to color the 

point cloud based on multiple return information and upper/lower limits. 

4. Range Limitations 

In reflectivity/intensity coloring modes, range limitations control the upper limits of reflectivity/intensity 

values used for coloring. For example, Falcon K uses a maximum of 256. Users can adjust this based on 

the LiDAR used or special requirements. 
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3.4.1.12 Pixel Size Adjustment 

This panel provides three interfaces to control the pixel size of the point cloud. Users can adjust according to usage. 

Generally, adjusting the basic pixel size should meet most needs. 

 
 

Ø Basic Pixel Size: Adjusting the basic pixel size changes the global pixel size. 

Ø Non-ROI Area Scaling: Adjusting the non-ROI size changes the pixel size outside the ROI area. 

Ø Distance Proportional Scaling: Adjusting distance scaling allows the point cloud to scale according to the 

distance from the origin. 
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4 Frame Synchronization 
Before using the frame synchronization feature, ensure that the PTP (Precision Time Protocol) time synchronization 
function is operating normally. It is recommended to use hardware timestamp synchronization. 

1. Enable Frame Synchronization Feature. 

echo set_i_config frame_sync enable 1|nc -nv <LIDAR_IP> <tcp_port> -w1 

echo get_i_config time |nc -nv <LIDAR_IP> <tcp_port> -w1  //确认帧同步功能是否开启 

 
Note: 
A return value of enable=1 indicates successful activation. 
<tcp_port> defaults to 8002. 

2. Specify Synchronization Time and Angle as Required. 

echo set_i_config frame_sync target_time <target_time> {[h_angle <h_angle>]| [v_angle <v_angle>]} 

 
【Parameter Description】 

• target_time： The target synchronization time, ranging from 0-99, in milliseconds (ms). 

• h_angle： The horizontal angle at the target synchronization point, default is 90 degrees (°). 

• v_angle： The vertical angle at the target synchronization point, default is 90 degrees (°). This 

indicates that at target_time, the frame synchronizes to the bottom left corner of the point cloud. 

3. Confirm Frame Synchronization Status. 

curl http://<LIDAR_IP>:<LIDAR_PORT>/command/?get_frame_sync_stats 
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【Parameter Explanation】 

• target_time： The set target synchronization time at a specified angle, in milliseconds (ms). 

• h_angle： The set horizontal angle of the synchronization point, in degrees (°). 

• v_angle： The set vertical angle of the synchronization point, in degrees (°). 

• Precision： The set synchronization precision, currently not modifiable, in milliseconds (ms). 

• Value： Current frame synchronization status, where 0 represents not synchronized, and 1 

represents synchronized. 

• time_sync_start_ms： The time when this frame synchronization adjustment began, in milliseconds 

(ms). 

• cost_time_ms： The time taken for this frame synchronization, i.e., from the start time to when 

synchronization first succeeds, in milliseconds (ms). 
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Appendix A: Upgrade the LiDAR  

1. Obtain an .img format upgrade package and connect the computer/master control unit that holds the 

upgrade package to the LiDAR, ensuring the network is connected. 
Note 
If needed, please contact Seyond staff to obtain the .img format upgrade package. The upgrade package includes 
both firmware and software upgrades. 

2. Change the IP address so that the computer's IP address is in the same subnet as the LiDAR's IP address. 

3. Open the Chrome browser and enter the LiDAR IP in the address bar. 
Note 
The default LiDAR IP address is 172.168.1.10. 
It is recommended to use the ping command to confirm smooth connectivity between the master control and the 
LiDAR, with a return value as shown. 

 

4. Click on Recovery/Update File。 

 

5. Click Choose File， which will open the 【Open】 window, then select the required upgrade package. 

 

6. Click 'Start Recovery/Update' to begin the upgrade. 

7. After the upgrade is complete, power off and restart the system. 

8.  (Optional) You can view the version information on the 【System info】 page. 
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Appendix B: Installing linuxptp Service 
Note 
This section only explains how to install the linuxptp service online on Ubuntu systems. If there is a need for 
offline installation of linuxptp, please contact Seyond staff. 

1. Install Dependencies. 

sudo apt update 

sudo apt install build-essential git 

2. Clone the linuxptp source code repository. 

git clone https://git.code.sf.net/p/linuxptp/code linuxptp 

cd linuxptp 

3. Switch to a specific version. 

git checkout <version_tag> 

4. Compile linuxptp. 

make 

5. Install linuxptp. 

sudo make install 

6. Verify the installation of linuxptp and confirm its version. 

ptp4l -v 

phc2sys -v 
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Appendix C: Command Line Format Explanation 
Format Meaning 
< > Indicates that the portion enclosed in < > must be replaced with an actual value 

during command configuration. 
[ ] Indicates that the portion enclosed in [ ] is optional during command configuration. 
[ x | y | ... ] Indicates a choice must be made between multiple options. 
// Lines starting with // denote comment lines 
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Appendix D: Common Troubleshooting 

Table 23: Common Issues and Solutions 

No. Fault Symptom Troubleshooting Steps 

1 
Network 
connection 
failure 

1． Check if the power supply voltage is normal. 

2． Ensure the power source is securely plugged in. 

3． Check if the power supply current is normal. 

4． Verify the software configuration is correct. 

5． Power off for at least one minute, then power on and test 

again. 

6． Ensure the Ethernet cable is properly connected. 

7． Check if network lights are flashing. 

8．Check if the host computer's network card is functioning 

properly, or replace the computer and test again. 

9． Ensure the host computer’s network card supports gigabit 

speeds. 

10． Verify the host computer’s IP address to ensure it is on the 

same local network as the device. 

2 
Point cloud 
display incorrect 
or not displaying 

1． Check if the firewall on the host computer is turned off. 

2． Use Wireshark packet capture tool to check if data packets are 

complete 

3． Check if the window is obstructed. 

4． Power off for at least one minute, then power on and test 

again. 

3 
Excessive noise in 
point cloud 

1． Check if the window is contaminated. 

2． Check if the target object is highly reflective. 

3． Power off for at least one minute, then power on and test 

again. 

4 
Incorrect point 
cloud field of 
view 

1． Check if the window is contaminated. 

2． Check if the window is obstructed. 

3． Verify the software configuration is correct. 
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No. Fault Symptom Troubleshooting Steps 

4． Power off for at least one minute, then power on and test 

again. 

5 
Ranging 
capability below 
standard 

1． Check if the window is contaminated. 

2． Consider the visibility conditions of the weather. 

3． Check if the window is obstructed. 

4． Verify if the LiDAR mechanical hardware settings are correct. 

5． Power off for at least one minute, then power on and test 

again. 

6 
Unable to 
synchronize time 

1． Check if the time synchronization interface connection is 

normal. 

 2． Verify if the timing service is running properly. 

 



Falcon K2 LiDAR User Manual 

Copyright©Seyond, Inc.  72  

Appendix E: Abbreviations and Terminology 

Table 24: Abbreviations 

Abbreviation Full Name 
AC Alternating Current 
DC Direct Current 
ETH Ethernet 
FAQ Frequently Asked Questions 
FOV Field of View 
GEN Generation 
GND Ground 
GPS Global Positioning System 
H × W × D Height × Width × Depth 
IP Internet Protocol 
LiDAR Light Detection and Ranging 
MAC Media Access Control 
MEC Multi-Access Edge Computing 
NTP Network Time Protocol 
PPS Pulse Per Second 
PTP Precision Time Protocol 
PWR Power 
ROI Region of Interest 
ROS Robot Operating System 
SDK Software Development Kit 
SN Serial Number 
SW Software 
TCP Transmission Control Protocol 
TOF Time of Flight 
UDP User Datagram Protocol 
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Table 25: Specialized Terms 

Term Definition 

Class 1 Laser 
Product 

A laser product where exposure to laser radiation under normal operating conditions does 
not exceed the emission limits that are considered safe for the eyes at the corresponding 
wavelength and emission duration. 

NTP 
Network Time Protocol (NTP) is a protocol used to synchronize computer clocks to Internet 
time servers, such as those received via radio or satellite receivers, or modem services. 

PTP 
Precision Time Protocol (PTP) is a high-accuracy time synchronization protocol primarily 
used for precise time synchronization between devices, but can also be adapted for 
frequency synchronization between them. 

Installer 
An installer refers to personnel who have professional training and extensive experience in 
the relevant field, fully understand the application of protective devices on machinery, and 
can assess their safety status. 

Commissioning 
Personnel  

Commissioning personnel are individuals with professional training and extensive 
experience in the relevant field, who fully understand the application of protective devices 
on machinery and can assess their safety status. 

Time-of-Flight 
Measurement 

Time-of-flight measurement determines distance by measuring the interval between when 
a signal is emitted and when it is received, as described in the Working Principle section. 

Laser Product 
Any product or component combination used to constitute or prepare to constitute a laser 
or laser system. Electronic product components sold to other manufacturers as a 
component do not fall under laser products. 

Laser 
A device that primarily generates or amplifies electromagnetic radiation in the wavelength 
range of 180 nanometers to 1 millimeter through a controlled laser emission process. 

Laser Device  A combination of laser products or a laser product containing lasers. 

Host Computer 

A computer that can directly issue control commands. Commands from the host are first 
sent to the subordinate machine, which then controls the device accordingly. The 
subordinate machine intermittently reads device status data, converts it into digital signals, 
and feeds it back to the host. 

Configuration 
Personnel 

Configuration personnel should possess professional knowledge and experience in the 
relevant field, have sufficient experience, and be able to evaluate whether the machine is 
in a safe operating state after using protective devices. 

Eye Safety 
Although the product design meets Class 1 eye safety standards, to maximize personal 
safety, do not use magnification devices (such as microscopes, magnifying glasses) to look 
directly at the laser during transmission. 

Maintenance 
Personnel 

Qualified maintenance personnel are those who have professional training and extensive 
experience in the relevant field, fully understand the application of protection devices on 
machinery, and have been guided by machine operation supervisors. 

Automotive 
Ethernet 

Automotive Ethernet is a new local area network technology used to connect electronic 
units within vehicles. 

削除: 

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APPENDIX H Multi-Scene Functionality 

H.1 Overview 

The Multi-Scene feature allows users to dynamically select from multiple scan patterns on Falcon LiDAR sensors. 
This capability is unique to the Falcon Series and provides enhanced flexibility for a wide range of application 
scenarios. 
The feature supports up to 8 additional scan patterns and includes 6 pre-configured scan patterns designed to 
cover the most common application needs. 

Availability: 

• Falcon K1: Firmware v5.4.33 and later 
• Falcon K2C: Firmware v1.82 and later 

H.2 Operation of the Multi-Scene Functionality 
Switching between scan patterns does not require re-programming. 
Users can control this feature via TCP or CURL commands. 
By default, this feature is disabled (OFF). 
The Multi-Scene feature can be controlled using the nc (netcat) utility or equivalent TCP client. 

Check whether the Multi-Scene feature is enabled 
echo get_i_config multi_scene enable | nc 172.168.1.10 8001 

Note: 172.168.1.10 8001 are the default LiDAR IP address and port. 
Replace with the actual LiDAR IP address and port number in use. 
Default value = 0, meaning the feature is OFF. 

Enable the Multi-Scene feature 
echo set_i_config multi_scene enable 1 | nc 172.168.1.10 8001 

Check the current scan pattern ID 
echo get_i_config multi_scene scene_id | nc 172.168.1.10 8001 
curl "http://172.168.1.10:8010/command/?get_multi_scene_id 

Default Scene ID = 0 
Available range = 0–8 

Change to a different scan pattern 
echo set_i_config multi_scene scene_id 3 | nc 172.168.1.10 8001curl 

"http://172.168.1.10:8010/command/?set_multi_scene_id scene_id" 
After command execution, the new scan pattern is applied immediately. 
Settings will remain active until manually changed or overwritten. 
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H.3 Definition of Scene IDs 

Scene ID Description Typical Use Case 

0 Default Scan Pattern Standard factory configuration 

1 Uniform Evenly distributed scanning lines 

2 Datasheet Default (Two ROIs) Dual-region scanning for near/far detection 

3 High Density Dense scan pattern for high-resolution environments 

4 Uniform 5 Hz Slow scan rate for static scene mapping 

5 Uniform 15 Hz Balanced scan rate for general navigation 

6 Uniform 20 Hz High-speed scan for dynamic applications 

7, 8 Reserved / Legacy FK Pattern Reserved for future firmware updates 
 

Scene ID:0 Default Scan Pattern 

 
 

Frame Rate (FPS) 10 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in ROI (deg) 0.08 
H_Res in ROI (deg) 0.089 
V_Res in Sparse (deg) 0.24 
H_Res in Sparse (deg) 0.178 
Lines per frame 152 
Vertical FOV 25 
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Scene ID:1 Uniform Scanning (Without ROI) 

 
Frame Rate (FPS) 10 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in Sparse (deg) 0.13 
H_Res in Sparse (deg) 0.125 
Lines per frame 152 
Vertical FOV 23.5 

Scene ID: 2 With two ROIs (Dual ROI to achieve 9.6) 

 
Frame Rate (FPS) 10 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in ROI (deg) 0.1 
H_Res in ROI (deg) 0.089 
V_Res in Sparse (deg) 0.24 
H_Res in Sparse (deg) 0.178 
Lines per frame 148 
Vertical FOV 21 
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Scene ID:3 High Resolution 

 
Frame Rate (FPS) 10 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in ROI (deg) 0.053 
H_Res in ROI (deg) 0.055 
V_Res in Sparse (deg) 0.24 
H_Res in Sparse (deg) 0.11 
Lines per frame 96 
Vertical FOV 4.8 

Scene ID:4 Uniform Scanning – Maximize vFOV, operation with 5Hz 

 
Frame Rate (FPS) 5 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in Sparse (deg) 0.09 
H_Res in Sparse (deg) 0.09 
Lines per frame 232 
Vertical FOV 25 
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Scene ID: 5 High frame rate, uniform scanning with 15fps 

 
Frame Rate (FPS) 15 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in Sparse (deg) 0.17 
H_Res in Sparse (deg) 0.15 
Lines per frame 112 
Vertical FOV 22 

Scene ID: 6 High frame rate, uniform scanning with 20fps  

 
Frame Rate (FPS) 20 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in Sparse (deg) 0.24 
H_Res in Sparse (deg) 0.14 
Lines per frame 72 
Vertical FOV 20 
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Scene ID: 7,8 Reserved for customized scanning pattern (default setting to the same as Scene ID 0) 
 

 
 

Frame Rate (FPS) 10 
Max_distance_for_10%_Target (m) 250 
Max_distance (m) 500 
V_Res in ROI (deg) 0.08 
H_Res in ROI (deg) 0.089 
V_Res in Sparse (deg) 0.24 
H_Res in Sparse (deg) 0.178 
Lines per frame 152 
Vertical FOV 25 
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ページ 18: [32] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [32] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [33] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [33] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [33] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [34] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [34] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

フォント : 太字 (なし)  

 

ページ 18: [34] 書式を変更   Leilei SHINOHARA   2025/10/13 17:12:00 

書式を変更

... [127]

書式を変更

... [128]

書式を変更

... [129]

書式を変更

... [130]

書式を変更

... [131]

書式を変更

... [132]

書式を変更

... [133]

書式を変更

... [134]



フォント : 太字 (なし)  

 

ページ 18: [35] 書式変更   Leilei SHINOHARA   2025/10/13 17:30:00 

インデント : 左 :  6 mm, ぶら下げインデント :  4.42 字, 間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  

1 行 

 

ページ 18: [36] 書式変更   Leilei SHINOHARA   2025/10/13 17:30:00 

インデント : 左 :  6 mm, ぶら下げインデント :  4.42 字, 間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  

1 行 

 

ページ 18: [37] 書式を変更   Leilei SHINOHARA   2025/10/13 17:31:00 

フォント : 太字 (なし) , スペル チェックと文章校正を行う 

 

ページ 18: [37] 書式を変更   Leilei SHINOHARA   2025/10/13 17:31:00 

フォント : 太字 (なし) , スペル チェックと文章校正を行う 

 

ページ 18: [37] 書式を変更   Leilei SHINOHARA   2025/10/13 17:31:00 

フォント : 太字 (なし) , スペル チェックと文章校正を行う 

 

ページ 18: [37] 書式を変更   Leilei SHINOHARA   2025/10/13 17:31:00 

フォント : 太字 (なし) , スペル チェックと文章校正を行う 

 

ページ 19: [38] 削除   Leilei SHINOHARA   2025/10/13 17:21:00 

 

書式を変更

... [135]

書式を変更

... [136]

書式を変更

... [137]

書式を変更

... [138]

書式を変更

... [139]

書式を変更

... [140]

書式を変更

... [141]



 

ページ 20: [39] 削除   Leilei SHINOHARA   2025/10/13 17:26:00 

 

ページ 39: [40] 削除   Leilei SHINOHARA   2025/10/13 18:53:00 

 

3.  

ページ 39: [40] 削除   Leilei SHINOHARA   2025/10/13 18:53:00 

 

4.  

ページ 39: [40] 削除   Leilei SHINOHARA   2025/10/13 18:53:00 

 

5.  

ページ 39: [41] コメントの追加 [LS1]   Leilei SHINOHARA   2025/10/13 12:12:00 

Please check the capture point cloud data with TCP, if the commands are correct 

 

ページ 39: [42] 書式変更   Leilei SHINOHARA   2025/10/13 18:55:00 

インデント : 左 :  7.8 mm, 行間 :  1 行,  行頭文字または番号を削除 

 

ページ 39: [43] 削除   Leilei SHINOHARA   2025/10/13 14:55:00 

 

 

ページ 39: [43] 削除   Leilei SHINOHARA   2025/10/13 14:55:00 

 

 

ページ 39: [44] 書式変更   Leilei SHINOHARA   2025/10/13 18:55:00 

間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  1 行 

 

ページ 39: [45] 削除   Leilei SHINOHARA   2025/10/13 12:03:00 

 

書式を変更

... [142]

書式を変更

... [143]

書式を変更

... [144]

書式を変更

... [145]

書式を変更

... [146]

書式を変更

... [147]

書式を変更

... [148]

書式を変更

... [149]

書式を変更

... [150]

書式を変更

... [151]

書式を変更

... [152]



ページ 39: [45] 削除   Leilei SHINOHARA   2025/10/13 12:03:00 

 

ページ 39: [45] 削除   Leilei SHINOHARA   2025/10/13 12:03:00 

 

ページ 39: [45] 削除   Leilei SHINOHARA   2025/10/13 12:03:00 

 

ページ 39: [46] 書式変更   Leilei SHINOHARA   2025/10/13 18:55:00 

インデント : 左 :  4 mm, 最初の行 :  4 mm, 間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  1 行 

 

ページ 39: [47] 削除   Leilei SHINOHARA   2025/10/13 12:06:00 

 

 

ページ 39: [47] 削除   Leilei SHINOHARA   2025/10/13 12:06:00 

 

 

ページ 39: [48] 書式変更   Leilei SHINOHARA   2025/10/13 18:55:00 

間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  1 行 

 

ページ 39: [49] 削除   Leilei SHINOHARA   2025/10/13 12:06:00 

 

ページ 39: [49] 削除   Leilei SHINOHARA   2025/10/13 12:06:00 

 

ページ 39: [50] 書式変更   Leilei SHINOHARA   2025/10/13 18:55:00 

インデント : 左 :  4 mm, 最初の行 :  4 mm, 間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  1 行 

 

ページ 39: [51] 書式変更   Leilei SHINOHARA   2025/10/13 18:55:00 

間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  1 行 

 

書式を変更

... [153]

書式を変更
... [154]

書式を変更

... [155]

書式を変更
... [156]

書式を変更

... [157]

書式変更
... [158]

書式を変更
... [159]

書式を変更
... [160]

書式変更

... [161]

書式を変更

... [162]

書式を変更
... [163]

書式を変更
... [164]

書式を変更

... [165]

書式を変更
... [166]

書式を変更
... [167]



ページ 39: [52] 削除   Leilei SHINOHARA   2025/10/13 12:10:00 

 

ページ 39: [53] 削除   Leilei SHINOHARA   2025/10/13 12:11:00 

 

 

ページ 39: [53] 削除   Leilei SHINOHARA   2025/10/13 12:11:00 

 

 

ページ 39: [54] 書式変更   Leilei SHINOHARA   2025/10/13 19:00:00 

インデント : 左 :  0 mm, ぶら下げインデント :  4.42 字, 行間 :  1 行 

 

ページ 39: [55] 削除   Leilei SHINOHARA   2025/10/13 18:59:00 

 

1.  

ページ 39: [56] 書式変更   Leilei SHINOHARA   2025/10/13 19:01:00 

間隔 段落前 :  3 pt, 段落後 :  3 pt, 行間 :  1 行 

 

ページ 40: [57] 削除   Leilei SHINOHARA   2025/10/13 12:14:00 

 

i.  

 

書式を変更

... [168]

書式を変更

... [169]

書式を変更

... [170]

書式を変更

... [171]

書式変更

... [172]

書式を変更

... [173]

書式を変更

... [174]

... [175]

書式を変更

... [176]


